MicroDicom DICOM Viewer
User manual
Version 2023.3
10/16/2023
# Table of contents

Welcome to MicroDicom DICOM Viewer ................................................................. 4  
Features .................................................................................................................. 4  
Contacts ................................................................................................................... 6  
Getting Started ..................................................................................................... 6  
  Installing MicroDicom DICOM viewer ................................................................. 7  
    Installation .......................................................................................................... 7  
    System requirements .......................................................................................... 12  
    Setup command-line arguments ....................................................................... 12  
Registration ............................................................................................................ 13  
Unregistration ........................................................................................................ 18  
MicroDicom basics ................................................................................................ 22  
  Open a DICOM file ............................................................................................. 22  
  Open DICOM files from a CD/DVD ...................................................................... 25  
  Open DICOMDIR file ........................................................................................... 26  
  Open DICOM files from a ZIP archive .................................................................. 29  
  Scan for DICOM files ........................................................................................... 32  
Split screen series viewing .................................................................................... 35  
  Multiple top-level windows ................................................................................ 35  
  Synchronization .................................................................................................. 36  
  Cross-reference lines ......................................................................................... 37  
Adding more DICOM images ................................................................................. 40  
DICOM tags ........................................................................................................... 41  
  DICOM tags dialog ............................................................................................... 41  
  DICOM tags pane ................................................................................................. 44  
  Edit DICOM tags ................................................................................................. 47  
  DICOM tag dictionary ......................................................................................... 50  
Printing .................................................................................................................... 51  
  Print ....................................................................................................................... 51  
  Print preview ....................................................................................................... 52  
  Print setup ........................................................................................................... 55  
Customizing ........................................................................................................... 57  
  Application look .................................................................................................. 57  
  Show/Hide Status Bar ......................................................................................... 57  
  Show/Hide DICOM browser ............................................................................... 57  
  Show/Hide DICOM Tags Pane ............................................................................ 57  
Reference ............................................................................................................... 57  
  Keyboard shortcuts .............................................................................................. 57  
  Command line arguments .................................................................................... 63  
  URL Protocol ...................................................................................................... 64  
  Mouse functions ................................................................................................. 65  
  Multi-touch operations ....................................................................................... 66
Welcome to MicroDicom DICOM Viewer

MicroDicom DICOM Viewer is an application for primary processing and preservation of medical images in DICOM format. MicroDicom is equipped with most common tools for manipulation of DICOM images, and it has an intuitive user interface. MicroDicom also has the advantage of being free for use and accessible to everyone for non-commercial use. If you want to use software for commercial, please see our Online Store.

This program has no CE mark (EU) or FDA approval (USA) nor any other national or international approval as medical device. It is therefore not to be used for clinical purposes and in any way to affect patient management.

Last changed on Monday, October 16, 2023, 11:10 AM.

Features

Why MicroDicom DICOM viewer?
- Free DICOM viewer for non-commercial use
- Lightweight DICOM viewer
- Over 15 years of active development
- Easy handling DICOM medical image data
- Intuitive interactive user interface
- Ultrafast performance
- Over 2 million downloads
- No advertisements

Handling DICOM medical image data
- Open medical images in DICOM format
- Open DICOM directory files
- Open images in common graphics formats (JPEG, BMP, PNG, GIF, TIFF)
- Display patient list from DICOMDIR
- Open images via drag & drop in the viewer
- Open images with double-click in File explorer
- Open ZIP files with medical images, ZIP files can be password protected
- Scan for DICOM medical images
- Displaying medical images from a CD
- DICOM Anonymizer
- Edit DICOM tags
Export DICOM files to images, movies, clipboard and text
MicroDicom DICOM viewer can export DICOM images to common graphics formats and videos. Our software can be used to convert JPEG, BMP images to DICOM images. Images can be sent to the Windows clipboard and after that paste in other applications.
- Export DICOM to JPEG, BMP, PNG, GIF, TIFF
- Export DICOM to WMV, AVI
- Export DICOM to text or Comma Separated Values (CSV) file
- Export DICOM image to clipboard
- Export JPEG, BMP, PNG, GIF, TIFF to DICOM
- Copy image to clipboard
- Automated open and copy DICOM images from CD/DVD
- Anonymize DICOM images
- DICOM converter - batch convert of JPEG, BMP, PNG, GIF, TIFF to DICOM

Patient CD/DVD/USB DICOM Viewer
We offer MicroDicom DICOM viewer CD/DVD/USB version. This autorun package can be burned with DICOM images together on CD/DVD/USB or other external storage. Our software runs from CD/DVD on other computers without installation. Users can insert a CD and autorun will start our viewer and show images that are written on the CD. It is suited for patient CD/DVD to show DICOM images without installation.

Viewing, Tools, Measurement and Annotations
Our software come up with many tools for operation over medical images.
- Brightness/contrast control
- Window/Level tool and presets
- Zooming, panning and scrolling DICOM images
- Rotate and flip
- Medical image processing operation
- Measurements and annotations – distance, free hand, rectangle, ellipse, angle, arrow, hide area, text, calibration, Cobb angle, open and closed curve
- Mean, median, minimum and maximum values, standard deviation
- Density in Hounsfield Units
- Zoom tool, Pan tool, Scroll tool
- Cine Loop for display real-time ultrasounds or angiography images
- Full Screen mode
- Display and edit DICOM tags of selected image
- Ability to show only favorite tags
- Multi-touch support
- Customizable toolbars for increased efficiency and productivity
- Customizable preferences
- Different application themes
- Applying image filters - blur, edge, sharpness, morphological

Split the screen for comparing different DICOM images
Series from different studies or examinations can be compared in our viewer. Images can be displayed side by side with splitting the view. You can compare images from same or different series. The images are synchronized by zoom and pan, slice position
and windowing. Cross-reference lines are used to identify the relative anatomical position. Scout or reference lines indicate the position and width of each cross-sectional image.

**Search and download DICOM images from PACS**

You can use MicroDicom DICOM viewer as PACS (Picture archiving and communication system) client. Our viewer easily can query and retrieve images from PACS locations, by using following DICOM protocols: C-ECHO, C-FIND, C-MOVE, C-GET, C-STORE. Also, you can send DICOM images to PACS servers or other computers.

**Supported DICOM files**

MicroDicom DICOM viewer can open studies produced by different medical equipment.
- Compressed and uncompressed RLE, JPEG Lossy, JPEG Lossless, JPEG2000 Lossy, JPEG2000 Lossless compressions
- Structured Reports, MPEG-2 and MPEG-4 transfer syntaxes, Encapsulated PDF
- Support medical images, produced by different medical equipment: CT, MRI, US, XA, CR, DX, CT, PET-CT, ...

**Print DICOM images on standard printer**

Can easily print DICOM images with MicroDicom. You have to choose images from a series, how much image per page and print. Also, you can hide sensitive information from the images before printing as name of patient, age, etc.

**DICOM viewer portable version**

The Zip package with our viewer is designed to be easily moved from one computing environment to another. Our portable version can be stored on USB drive and use on different computers.

**Contacts**

**Website**

https://www.microdicom.com

**E-mail:**

info@microdicom.com
support@microdicom.com
sales@microdicom.com

**Address:**

st. Yana Yazova 12
Sofia, Bulgaria
+359888919593

Send your suggestions, questions and issues to our email.

**Getting Started**

- Installation
- Activation
Installing MicroDicom DICOM viewer

- Installation
- System requirements
- Setup command-line arguments

Installation

Open download page of MicroDicom DICOM Viewer
https://www.microdicom.com/downloads.html

You can use installation package or portable zip packages.

Installation package

Download installation package on your computer. You can choose between 32 or 64 bit version of installer.
- MicroDicom DICOM viewer x86 is 32 bit version
Welcome to MicroDicom DICOM Viewer

- **MicroDicom DICOM viewer x64** is 64 bit version

Click on the downloaded installer file to run it.

Windows will show "User Account Control" alert. You have to click **Yes** to start the installation.

Complete the following steps.
Welcome to MicroDicom DICOM Viewer

Welcome to MicroDicom DICOM viewer 4.0.0 Setup

Setup will guide you through the installation of MicroDicom DICOM viewer 4.0.0.

It is recommended that you close all other applications before starting Setup. This will make it possible to update relevant system files without having to reboot your computer.

Click Next to continue.

License Agreement

Please review the license terms before installing MicroDicom DICOM viewer 4.0.0.

Press Page Down to see the rest of the agreement.

End-User License Agreement for MicroDicom DICOM viewer

READ CAREFULLY: This End-User License Agreement (“EULA”) is a legal agreement between you (“end user”) and MicroDicom (“the author”) for the “MicroDicom DICOM Viewer”, which includes computer software and may include associated media, printed materials and ‘online’ or electronic documentation (“SOFTWARE PRODUCT”). You agree to be bound by the terms of this EULA by installing, copying or otherwise using the product. If you do NOT agree, do NOT install or use the SOFTWARE PRODUCT.

1. Grant of license. The author grants and user the following rights provided that you comply with all terms and conditions of this EULA:

If you accept the terms of the agreement, click I Agree to continue. You must accept the agreement to install MicroDicom DICOM viewer 4.0.0.

I Agree
When you click the **Finish** button on the last step, MicroDicom is installed and will be run for the first time on your machine.
Portable zip package

Download portable zip package on your computer. You can choose between 32 or 64 bit version of portable package.

- **MicroDicom DICOM viewer x86 zip** is 32 bit version
- **MicroDicom DICOM viewer x64 zip** is 64 bit version

Unzip content of the package on your hard drive.
Just double-click on mDicom.exe and MicroDicom DICOM Viewer will run.

**System requirements**

- Intel or AMD 1GHz or faster processor
- 512 MB of RAM or more
- 14 MB of free disk space for installation
- 1024x768 screen resolution or higher

MicroDicom DICOM Viewer is an application for Windows system. But you can easily run it on macOS using Wine or CrossOver MAC software.

**Setup command-line arguments**

Installers accept a few options on the command line. These options give the user a bit more control over the installation process.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/S</td>
<td>Runs the installer silently.</td>
</tr>
<tr>
<td>/D</td>
<td>Sets the default installation directory. It must be the last parameter used in the command line and must not contain any quotes, even if the path contains spaces. Only absolute paths are supported.</td>
</tr>
</tbody>
</table>

You can use in command line 'MicroDicom-X.X.X-win64.exe /S'. Note that /S is uppercase and X.X.X is version of installer.

Example: MicroDicom-4.0.0-x64.exe /S /D=C:\Program Files\MicroDicom
Welcome to MicroDicom DICOM Viewer

Registration

Registration via UI

2. The Registration dialog is shown on startup if it has not already been filled once or show the Registration dialog when click "Registration..." in Help menu. or show the Registration dialog when click "Enter a license key..." in Help menu if you are already in Trial or Non-commercial mode.

- I want to evaluate - You will have 14 days to evaluate the software. After that, you can extend the evaluation period, or you have to purchase a license from us.
- I confirm that I will use it for non-commercial - you have to confirm that you will use it only for non-commercial.
- I have a serial number - if you have already purchased a license from us, you can enter your serial key.

3. Just paste your name, email and serial number that you received after payment in the following dialog and click Next button.

- The serial number and email are case-sensitive!
- Please do not share your key with others!
4. MicroDicom DICOM Viewer will try to connect to the license server.

5. Now you have register version of MicroDicom DICOM Viewer.
Offline registration

1. If your computer is not connected to the Internet, you will see the page for offline registration after Step 4 in Registration via UI.

3. Get Activation code and enter it in the Offline page.

4. Click Next button.

4. Now you have register version of MicroDicom DICOM Viewer.
Registration via command line

Automatic registration with Internet access

mDicom.exe -registerOnline -LicenseName <name> -LicenseEmail <email> -SerialNumber <serial number>

Example:
mDicom.exe -registerOnline -LicenseName "John Smith" -LicenseEmail "john.smith@sample.com" -SerialNumber XXXX-XXXX-XXXX-XXXX

Without Internet access

1. Generate code

mDicom.exe -registerOfflineGenerateCode

3. Get Activation code

4. Register with activation code

Unregistration

Unregistration via UI

1. Click Unregister... from the Help menu
2. Unregistration dialog is shown. You have to confirm that you want to remove your license from this computer and click Next.

3. MicroDicom DICOM Viewer will try to connect to the license server.
4. Your license is removed from this computer.

**Offline unregistration**

1. If your computer is not connected to the Internet, you will see the page for offline registration after Step 3 in Registration via UI.
2. Go to https://www.microdicom.com/unregister and enter Serial number and Code from Offline page. Click Unregister button.

3. Click Next button and your license is removed from this computer.
Unregistration via command line

You can unregister your license with the following command:

mDicom.exe -unregisterLicense

MicroDicom basics

- Open a DICOM file
- Open DICOM files from a CD/DVD
- Open DICOMDIR file
- Open DICOM files from a ZIP archive
- Scan for DICOM files

Open a DICOM file

Open files within application

1. Open File menu and click on Open...
or click **Open** command on the Standard toolbar

or use **Ctrl + O** keyboard shortcut

2. Open dialog is shown, select DICOM files that you want to open and click the **Open** button. You can also open BMP, GIF, JPG, PNG, TIFF, WMF files.

The following options allow you to specify which file to open:

**File Name** - Specifies the file you want to open. This box lists files with the extension you select in the List Files of Type field.

**List Files of Type** - Specifies the type of file you want to open: All files(*.*), All DICOM files(*.dcm,*.dcm30), DICOM files(*.dcm), DICOM 3.0 files(*.dcm30), DICOM ZIP files(*.dmz)
3. Files will be loaded into MicroDicom DICOM Viewer.

Open files directly from a File Explorer via drag & drop or double click

- Drag & drop files on MicroDicom's main window
Welcome to MicroDicom DICOM Viewer

Double mouse click on a DICOM file in File Explorer or right mouse click **Open with** MicroDicom DICOM Viewer

Open DICOM files from a CD/DVD

1. Open **File** menu and click on **Open CD/DVD**
Welcome to MicroDicom DICOM Viewer or click the **Open CD/DVD** command on the Standard toolbar

or use **Alt + O** keyboard shortcut

2. Files will be loaded into MicroDicom DICOM Viewer.

**Open DICOMDIR file**

**Open DICOMDIR file within application**

1. Open **File** menu and click on **Open DICOMDIR...**
or click the **Open DICOMDIR** command on the Standard toolbar

or use **Ctrl + Alt + O** keyboard shortcut

2. Open dialog is shown, select DICOMDIR file that you want to open and click the **Open** button.

The following options allow you to specify which file to open:

**File Name** - Specifies the file you want to open.
Welcome to MicroDicom DICOM Viewer

3. Files will be loaded into MicroDicom DICOM Viewer.

![Image of file loading process]

**Open files directly from a File Explorer via drag & drop**

- Drag & drop files on MicroDicom's main window
Open DICOM files from a ZIP archive

Open DICOM ZIP archive within application

1. Open **File** menu and click on **Open ZIP file...**

or click **Open ZIP file...** command on the Standard toolbar
2. Open ZIP file dialog is shown, select the ZIP file that you want to open and click the **Open** button.

3. A password may be required if the archive is password protected.

4. Files from the archive will be extracted in a temp folder and will be scanned for DICOM files.

5. Files will be loaded into MicroDicom DICOM Viewer.
Open ZIP archive files directly from a File Explorer via drag & drop or double click

- Drag & drop ZIP files on MicroDicom's main window
- Right mouse click and choose **Open with MicroDicom DICOM Viewer**
Welcome to MicroDicom DICOM Viewer

Scan for DICOM files

Scan folder for DICOM files within application

1. Open File menu and click on Scan for DICOM files...

or click Scan for DICOM files command on Standard toolbar
or use Ctrl + Shift + O keyboard shortcut

2. Choose the folder that you want to scan for DICOM files and click **OK**.

3. Files from the folder will be loaded into MicroDicom DICOM Viewer.
Scan for DICOM files directly from a File Explorer via drag & drop or Open with MicroDicom DICOM Viewer in context menu

- Drag & drop folders on MicroDicom's main window

- Right mouse click on folders in File Explorer and click Open with MicroDicom DICOM Viewer
Welcome to MicroDicom DICOM Viewer

Split screen series viewing

Multiple top-level windows
Synchronization
Cross-reference lines
Adding more DICOM images

Multiple top-level windows

You can open different top-level windows. Open File menu and click New Window or press Ctrl+N. Also, you can start new top-level windows via MicroDicom DICOM Viewer shortcut from Start menu or Desktop.
Use the **Duplicate Window** command in **File** menu or press **Ctrl+D** to open a new top-level window with patients from the active top-level window.

**Synchronization**

Use synchronization to set same slice position, zoom & pan and windowing to the images opened in the **Split screen**. You can synchronize images from same series or different series, same study or different studies. Images have to be from the same or similar plane.

Synchronization settings are located in **View** menu / **Synchronization**.
- switch on/off Slice position synchronization
- switch on/off Zoom & Pan synchronization
- switch on/off Windowing synchronization
- switch on/off synchronization from same study
- switch on/off synchronization from different study
Cross-reference lines

Cross-reference lines are used in MR and CT series to identify the relative anatomical position of a collection of cross-sectional images. Scout or reference lines indicate the position of each cross-sectional image.

Firstly, you have to display several different series in Split Screen mode. Cross-reference lines are shown on inactive views and indicate the position of the image on active view.

Reference lines are 3 types:

- current reference line is shown in red. Also, slice thickness is displayed with dotted lines.
- boundary reference lines are shown in green. They depict the first and last image in a series.
- intermediate lines are shown in yellow and depict reference lines on all images in a series.
You can switch on or off current, boundary and intermediate lines in the **Measure and annotate** menu.
There are settings for **Cross-reference lines** in the **Options dialog** (Tools/Options).

- switch on/off visibility
- change colors
- change opacity
- show slice number
Adding more DICOM images

After already opened DICOM images in the application, you can add new images from other locations. You have to use Add DICOM images. This menu exist in two locations: File menu and toolbar of the DICOM browser pane. New DICOM images can be added from a folder or a single file.
DICOM tags

- DICOM tags dialog
- DICOM tags pane
- Edit DICOM tags
- DICOM tag dictionary

**DICOM tags dialog**

By viewing the DICOM tags, you can access additional information that goes beyond what is visually displayed on the image. This metadata provides crucial details about the image, patient demographics, imaging parameters, and other relevant information, enhancing the understanding and analysis of the medical image.
To access the DICOM tags associated with the displayed image, click **View** menu and **DICOM Tags...**

![DICOM Tags](image)

You can use **Search** field to find tags by specific text. It will search in group/element, tag description and value.

Clicking with the right mouse button on the list will show the context menu.

- Copy - copy all fields of the selected tag to the clipboard (Ctrl+C)
- Copy All - copy all tags to the clipboard (Ctrl+A and Ctrl+C)
- Copy Value - copy value of the selected tag to the clipboard
- Add to Favorite - add selected tag to the **Favorite Tags** pane

Copyright © 2007 - 2023 by MicroDicom. All Rights Reserved.
Use the **Export** drop down menu to export all DICOM tags to a text file or CSV file.
If you want to edit DICOM tags, read following topic: Edit DICOM tags

**DICOM tags pane**

DICOM tags pane give ability for quick view of DICOM tags on current image.

There are three tabs:

- **Patient information** tab - common DICOM tags for Patient, Study and Series
- **All Tags** tab - all DICOM tags of current image
- **Favorite Tags** tab - show only tags that are marked as favorite by the user
<table>
<thead>
<tr>
<th>Group.E..</th>
<th>TAG Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0002,0000</td>
<td>File Meta Information Group Length</td>
<td>234</td>
</tr>
<tr>
<td>0002,0001</td>
<td>File Meta Information Version</td>
<td>00,01</td>
</tr>
<tr>
<td>0002,0002</td>
<td>Media Storage SOP Class UID</td>
<td>1.2.840.10008.5.15.1024</td>
</tr>
<tr>
<td>0002,0003</td>
<td>Media Storage SOP Instance UID</td>
<td>1.3.12.2.1107.5.8.3</td>
</tr>
<tr>
<td>0002,0010</td>
<td>Transfer Syntax UID</td>
<td>1.2.840.10008.1.0</td>
</tr>
<tr>
<td>0002,0012</td>
<td>Implementation Class UID</td>
<td>2.16.840.1.11366</td>
</tr>
<tr>
<td>0002,0013</td>
<td>Implementation Version Name</td>
<td>dicomapi.dll version</td>
</tr>
<tr>
<td>0002,0016</td>
<td>Source Application Entity Title</td>
<td>dicom browser</td>
</tr>
<tr>
<td>0008,0005</td>
<td>Specific Character Set</td>
<td>ISO_IR 100</td>
</tr>
<tr>
<td>0008,0008</td>
<td>Image Type</td>
<td>ORIGINAL\PRIM</td>
</tr>
<tr>
<td>0008,0016</td>
<td>SOP Class UID</td>
<td>1.2.840.10008.5.15.1024</td>
</tr>
<tr>
<td>0008,0018</td>
<td>SOP Instance UID</td>
<td>1.3.12.2.1107.5.8.3</td>
</tr>
<tr>
<td>0008,0020</td>
<td>Study Date</td>
<td>20051014</td>
</tr>
<tr>
<td>0008,0021</td>
<td>Series Date</td>
<td>20051014</td>
</tr>
<tr>
<td>0008,0022</td>
<td>Acquisition Date</td>
<td>20051014</td>
</tr>
<tr>
<td>0008,0023</td>
<td>Content Date</td>
<td>20051014</td>
</tr>
<tr>
<td>0008,0030</td>
<td>Study Time</td>
<td>125256.915000</td>
</tr>
<tr>
<td>0008,0031</td>
<td>Series Time</td>
<td>125435.474000</td>
</tr>
<tr>
<td>0008,0032</td>
<td>Acquisition Time</td>
<td>125436.850000</td>
</tr>
<tr>
<td>0008,0033</td>
<td>Content Time</td>
<td>125449.475000</td>
</tr>
<tr>
<td>0008,0050</td>
<td>Accession Number</td>
<td>anonymized</td>
</tr>
<tr>
<td>0008,0060</td>
<td>Modality</td>
<td>MR</td>
</tr>
<tr>
<td>0008,0070</td>
<td>Manufacturer</td>
<td>SIEMENS</td>
</tr>
<tr>
<td>0008,0080</td>
<td>Institution Name</td>
<td>anonymized</td>
</tr>
<tr>
<td>0008,0090</td>
<td>Referring Physician Name</td>
<td>anonymized</td>
</tr>
<tr>
<td>0008,1010</td>
<td>Station Name</td>
<td>anonymized</td>
</tr>
<tr>
<td>0008,103E</td>
<td>Series Description</td>
<td>anonymized</td>
</tr>
</tbody>
</table>
You can use **Search** field to find tags by specific text.

Clicking with the right mouse button on the list of **All tags** tab will show the context menu:

- Copy - copy all fields of the selected tag to the clipboard
- Copy All - copy all tags to the clipboard
- Copy Value - copy value of the selected tag to the clipboard
- Add to Favorite - add selected tag to the **Favorite Tags** pane
If you want to edit DICOM tags, read following topic: Edit DICOM tags

### Edit DICOM tags

Editing DICOM tags requires caution and adherence to the DICOM standard to ensure the integrity and consistency of the data. Modifying DICOM tags without a thorough understanding of the implications can lead to incorrect information and potential harm.

#### Editing DICOM tags via Patient Information tab in the DICOM Tags pane

Double click with mouse to change the value in the Patient information list. Also, you can show the context menu and click Edit.
After editing of a DICOM tag, you have to confirm the change.

**Editing DICOM tags via the DICOM tags dialog**
You can edit all DICOM tags in a file when you open the **DICOM tags dialog**. After opening the DICOM tags dialog, you have to enter in editing mode as clicking ![Edit](edit.png) button.

After that you can double click with mouse to change the value, **Add** a new DICOM tag, **Remove** a tag.
All changes are shown in red. You can review them, before applying the changes to the file with **Apply** button.
The changes can be applied on current image only or on all images in current series, study and patient.

**DICOM tag dictionary**

The DICOM Tag Dictionary is a comprehensive collection of DICOM tags along with their definitions and attributes. It serves as a reference guide for understanding the various metadata elements used in DICOM files.

To access the DICOM tag dictionary, click **Tools** menu and **DICOM tag dictionary**...
Welcome to MicroDicom DICOM Viewer

You can use **Search** field to find tags by specific text. It will search in group/element and tag description.

**Printing**

- **Print**
- **Print preview**
- **Print setup**

**Print**

**Print command (File menu)**
Use this command to print DICOM images. This command presents a Print dialog box, where you may specify the range of pages to be printed, the number of copies, the destination printer, and other printer setup options.

**Print dialog box**
The following options allow you to specify how the document should be printed:

### Printer
Displays the active printer and printer connection. Choose the **Setup** option to change the printer and printer connection.

### Print Range
Specifies the pages you want to print:
- **All**: Prints the entire document.
- **Selection**: Prints the currently selected text.
- **Pages**: Prints the range of pages you specify in the **From** and **To** fields.

### Copies
Specifies the number of copies you want to print for the above page range.

### Print Progress Dialog
The Printing dialog box is shown during the time that MicroDicom is sending output to the printer. The page number indicates the progress of the printing.

To abort printing, choose Cancel.

### Print preview

**Print Preview command (File menu)**

Use this command to display the active document as it would appear when printed. When you choose this command, the main window will be replaced with a print preview window in which one or two pages will be displayed in their printed format. The print preview toolbar offers you options to view either one or two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a print job.
Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Opens the Print dialog box to start a print job.

Portrait and Landscape
Change page orientation

Layout
Specifies how many images to be print on a page.

Measure and annotation
You can choose to show or not measurements and annotations.

DICOM frames
Specifies whether to print all DICOM frames.

Source
Specifies what have to be print - current image, images from current series, images from current study or all images from current patient.

Format
Specifies whether images will be print as they are stored or how they are displayed in the view.

Overlays
Specifies what will be printed on the images - All overlay, Anonymous overlay or Without overlay.

Header
Specifies what will be printed in the header - page number and DICOM information.

Footer
Specifies what will be printed in the footer - page number and text.

Next Page
Previews the next printed page.
Welcome to MicroDicom DICOM Viewer

**Prev Page**
Previews the previous printed page.

**One Page / Two Page**
Previews one or two printed pages at a time.

**Zoom In**
Takes a closer look at the printed page.

**Zoom Out**
Takes a larger look at the printed page.

**Image select Pane**
Show/Hide Image select pane

**Print setup**
Show [Print Setup dialog box](#)

**Close**
Returns from print preview to the editing window.

You can use the **Image select pane** to choose which image to be printed.
Print setup

Print Setup dialog box

The following options allow you to select the destination printer and its connection.

**Printer**

Specifies the printer you want to use. Choose the default printer, or choose
Welcome to MicroDicom DICOM Viewer

the **Specific Printer option** and select one of the current installed printers shown in the box. You install printers and configure ports using Control Panel.

**Orientation**

Specifies **Portrait** or **Landscape**.

**Paper Size**

Specifies the size of paper that the document is to be printed on.

**Paper Source**

Specifies the paper source, because some printers offer multiple trays for different paper sources.

**Image source**

Specifies what have to be print - current image, images from current series, images from current study or all images from current patient.

**Show all DICOM frames of image**

Specifies whether to print all DICOM frames.

**Layout**

Specifies how many images to be print on a page.

**Format**

 Specifies whether images will be print as they are stored or how they are displayed in the view.

**Header**

 Specifies what will be printed in the header - page number and DICOM information.

**Footer**

 Specifies what will be printed in the footer - page number and text.

**Image information**

 Specifies what will be printed on the images - All overlay, Anonymous overlay or Without overlay. Also, you can choose to show or not measurements and annotations.

**Network**

Click this button to connect to a network location, assigning it a new drive letter.
Customizing

Application look
You can change how the application is going to look. To access the application styles, click View menu and Application Look. You can choose between four color styles.

- Blue Style
- Black Style
- Silver Style
- Aqua Style

Show/Hide Status Bar

Status Bar command (View menu)
Use this command to display and hide the status bar. A checkmark appears next to the menu item when the status bar is displayed.

Show/Hide DICOM browser

DICOM Browser command (View menu)
Use this command to display and hide the DICOM browser pane, which includes view and commands for opened images in MicroDicom. A checkmark appears next to the menu item when the DICOM browser is displayed.

Show/Hide DICOM Tags Pane

DICOM Tags Pane command (View menu)
Use this command to display and hide the DICOM Tags pane, which includes a view of DICOM tags for the current displayed image in MicroDicom. A checkmark appears next to the menu item when the DICOM Tags pane is displayed.

Reference

- Keyboard shortcuts
- Command line arguments
- Mouse functions
- Multi-touch operations

Keyboard shortcuts

<table>
<thead>
<tr>
<th>Main keyboard shortcuts</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Open DICOM file</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Open CD/DVD</td>
<td>Alt+O</td>
</tr>
</tbody>
</table>
## Welcome to MicroDicom DICOM Viewer

<table>
<thead>
<tr>
<th>Feature</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open DICOMDIR file</td>
<td>Ctrl+Alt+O</td>
</tr>
<tr>
<td>Scan folder for DICOM files</td>
<td>Ctrl+Shift+O</td>
</tr>
<tr>
<td>Open ZIP file</td>
<td>Alt+Shift+O</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Download from DICOM server</td>
<td>Shift+F</td>
</tr>
<tr>
<td>Options</td>
<td>Ctrl+J</td>
</tr>
<tr>
<td>Play/pause cine</td>
<td>Enter</td>
</tr>
<tr>
<td>Stop cine</td>
<td>Ctrl+Shift+Enter</td>
</tr>
<tr>
<td>New Window</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Duplicate Window</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Refresh</td>
<td>F5</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
<tr>
<td>Context help</td>
<td>Shift+F1</td>
</tr>
</tbody>
</table>

### Images

<table>
<thead>
<tr>
<th>Feature</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip horizontal</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>Flip vertical</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Rotate left</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Rotate right</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Flip/Rotate restore</td>
<td>Ctrl+Alt+R</td>
</tr>
<tr>
<td>Image size</td>
<td>Shift+S</td>
</tr>
<tr>
<td>Copy to clipboard</td>
<td>Shift+Alt+C</td>
</tr>
<tr>
<td>Copy Split screen to clipboard</td>
<td>Shift+C</td>
</tr>
</tbody>
</table>
### Export

<table>
<thead>
<tr>
<th>Export</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export to picture</td>
<td>Shift+P</td>
</tr>
<tr>
<td>Export to video</td>
<td>Shift+V</td>
</tr>
<tr>
<td>Export to DICOM</td>
<td>Shift+D</td>
</tr>
<tr>
<td>Export to text</td>
<td>Shift+T</td>
</tr>
<tr>
<td>Export to clipboard</td>
<td>Shift+C</td>
</tr>
</tbody>
</table>

### Tools, Annotation and Measurement

<table>
<thead>
<tr>
<th>Tool</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use distance tool</td>
<td>D</td>
</tr>
<tr>
<td>Use angle tool</td>
<td>A</td>
</tr>
<tr>
<td>Use arrow tool</td>
<td>O</td>
</tr>
<tr>
<td>Use calibrate tool</td>
<td>C</td>
</tr>
<tr>
<td>Use closed curve tool</td>
<td>L</td>
</tr>
<tr>
<td>Use opened curve tool</td>
<td>V</td>
</tr>
<tr>
<td>Use cobb angle tool</td>
<td>N</td>
</tr>
<tr>
<td>Use ellipse tool</td>
<td>E</td>
</tr>
<tr>
<td>Use rectangle tool</td>
<td>R</td>
</tr>
<tr>
<td>Use freehand tool</td>
<td>H</td>
</tr>
<tr>
<td>Use text tool</td>
<td>T</td>
</tr>
<tr>
<td>Use select tool</td>
<td>Esc</td>
</tr>
<tr>
<td>Use scroll tool</td>
<td>F</td>
</tr>
<tr>
<td>Use zoom tool</td>
<td>Z</td>
</tr>
<tr>
<td>Use windowing tool</td>
<td>W</td>
</tr>
<tr>
<td>Action Description</td>
<td>Shortcut</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Use pan tool</td>
<td>P</td>
</tr>
<tr>
<td>Copy object (annotation, measurement)</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Copy all viewable object (annotation, measurement)</td>
<td>Ctrl+Shift+C</td>
</tr>
<tr>
<td>Cut object (annotation, measurement)</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Paste object (annotation, measurement)</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete object (annotation, measurement)</td>
<td>Del</td>
</tr>
<tr>
<td>Delete all object in all opened images</td>
<td>Ctrl+Shift+Del</td>
</tr>
<tr>
<td>Delete all object in current image</td>
<td>Ctrl+Del</td>
</tr>
<tr>
<td>Delete all object in current series</td>
<td>Shift+Del</td>
</tr>
<tr>
<td>Select all object</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Deselect all object</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td>Duplicate all selected object in all images of the series</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Increase font size of selected object</td>
<td>Ctrl+Num+</td>
</tr>
<tr>
<td>Decrease font size of selected object</td>
<td>Ctrl+Num-</td>
</tr>
<tr>
<td>Increase thickness of selected object</td>
<td>Shift+Num+</td>
</tr>
<tr>
<td>Decrease thickness of selected object</td>
<td>Shift+Num-</td>
</tr>
<tr>
<td>Show/hide annotations and measurements</td>
<td>F9</td>
</tr>
<tr>
<td>Hold it during Ellipse tool to make a circle, during</td>
<td>Shift</td>
</tr>
<tr>
<td>Function Description</td>
<td>Key(s)</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Rectangle and Hide area tool to make a square, hold it during Distance, Calibrate, Arrow tool to make horizontal or vertical lines</td>
<td></td>
</tr>
<tr>
<td>Hold it during Angle and Cobb Angle tool to make angle through 10 degree</td>
<td>Shift</td>
</tr>
<tr>
<td>Hold it during resizing of Ellipse, Rectangle, Hide area, Distance, Arrow tool to make resizing relative to center of the object</td>
<td>Ctrl</td>
</tr>
</tbody>
</table>

**Brightness/contrast (Windowing)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default brightness/contrast</td>
<td>0</td>
</tr>
<tr>
<td>Full dynamic brightness/contrast</td>
<td>1</td>
</tr>
<tr>
<td>2nd window preset (Skull)</td>
<td>2</td>
</tr>
<tr>
<td>3rd window preset (Lung)</td>
<td>3</td>
</tr>
<tr>
<td>4th window preset (Abdomen)</td>
<td>4</td>
</tr>
<tr>
<td>5th window preset (Mediastinum)</td>
<td>5</td>
</tr>
<tr>
<td>6th window preset (Bone)</td>
<td>6</td>
</tr>
<tr>
<td>7th window preset (Spine)</td>
<td>7</td>
</tr>
<tr>
<td>8th window preset (Postmyelo)</td>
<td>8</td>
</tr>
<tr>
<td>9th window preset (Felsenbein)</td>
<td>9</td>
</tr>
<tr>
<td>Invert (Negative)</td>
<td>F7</td>
</tr>
<tr>
<td>Edit brightness/contrast</td>
<td>Shift+W</td>
</tr>
<tr>
<td>View</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Fit to screen</td>
<td>Shift+1</td>
</tr>
<tr>
<td>Fullscreen</td>
<td>F11</td>
</tr>
<tr>
<td>1:1 resolution. Set zoom to 100%</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>Show/Hide overlay</td>
<td>Ctrl+F9</td>
</tr>
<tr>
<td>Show/Hide patient information</td>
<td>Shift+F9</td>
</tr>
<tr>
<td>Show DICOM tags dialog</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Show/hide DICOM tags pane</td>
<td>Ctrl+Shift+T</td>
</tr>
<tr>
<td>Show/hide DICOM browser pane</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Next image</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Previous image</td>
<td>Up arrow</td>
</tr>
<tr>
<td>Next image in current series</td>
<td>Right arrow</td>
</tr>
<tr>
<td>Previous image in current series</td>
<td>Left arrow</td>
</tr>
<tr>
<td>Next series</td>
<td>Ctrl + Down arrow</td>
</tr>
<tr>
<td>Previous series</td>
<td>Ctrl + Up arrow</td>
</tr>
<tr>
<td>Next patient</td>
<td>Shift+Down arrow</td>
</tr>
<tr>
<td>Previous patient</td>
<td>Shift+Up arrow</td>
</tr>
<tr>
<td>View first patient</td>
<td>Home</td>
</tr>
<tr>
<td>View last patient</td>
<td>End</td>
</tr>
<tr>
<td>View before 10 images</td>
<td>Page Up</td>
</tr>
<tr>
<td>View after 10 images</td>
<td>Page Down</td>
</tr>
</tbody>
</table>
**Command line arguments**

You can use the following command-line arguments:

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a DICOM file</td>
<td><code>mDicom.exe &lt;path_to_DICOM_file&gt;</code></td>
</tr>
<tr>
<td>Open a DICOMDIR file</td>
<td><code>mDicom.exe &lt;path_to_DICOMDIR_file&gt;</code></td>
</tr>
<tr>
<td>Open a DICOM zip file</td>
<td><code>mDicom.exe &lt;path_to_zip_file&gt;</code></td>
</tr>
<tr>
<td>Scan a folder for DICOM files</td>
<td><code>mDicom.exe &lt;path_to_directory_to_scan&gt;</code></td>
</tr>
<tr>
<td>Open DICOM files and folders</td>
<td><code>mDicom.exe -fd &lt;path_to_file1&gt; &lt;path_to_file2&gt; &lt;path_to_folder&gt;</code></td>
</tr>
<tr>
<td>Open MicroDicom in full screen mode</td>
<td><code>mDicom.exe -fullscreen</code></td>
</tr>
<tr>
<td>Scan for DICOM files and copy them to a folder</td>
<td>`mDicom.exe -scanAndCopy -in &lt;path_to_folder</td>
</tr>
<tr>
<td>Example</td>
<td><code>mDicom.exe -scanAndCopy -in &quot;c:\images&quot; -out &quot;c:\export&quot;</code></td>
</tr>
<tr>
<td></td>
<td>`mDicom.exe -scanAndCopy -in &quot;c:\images</td>
</tr>
<tr>
<td>Scan CD for DICOM files and copy them to a folder</td>
<td><code>mDicom.exe -scanCDAndCopy -out &lt;path_to_folder&gt;</code></td>
</tr>
<tr>
<td>Show progress bar and messages on command line</td>
<td><code>mDicom.exe -showUI</code></td>
</tr>
<tr>
<td>Example</td>
<td><code>mDicom.exe -scanCDAndCopy -showUI -out &quot;C:\export&quot;</code></td>
</tr>
<tr>
<td>Scan for DICOM files and convert to other format</td>
<td>`mDicom.exe -scanAndConvert -format &lt;jpeg</td>
</tr>
<tr>
<td>Example</td>
<td><code>mDicom.exe -scanAndConvert -format jpeg -in &quot;c:\images&quot; -out &quot;c:\export&quot;</code></td>
</tr>
</tbody>
</table>
Welcome to MicroDicom DICOM Viewer

<table>
<thead>
<tr>
<th>Example: mDicom.exe -anonymize -in &quot;c:\images&quot; -out &quot;c:\export&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;path_to_folder&gt;</td>
</tr>
<tr>
<td>Download and show studies by tag value.</td>
</tr>
<tr>
<td>Search in all PACS servers from the settings</td>
</tr>
<tr>
<td>mDicom.exe -pacsTagValue 00100020 &quot;PatientID&quot;</td>
</tr>
<tr>
<td>mDicom.exe -pacsTagValue 00100010 &quot;PatientName&quot;</td>
</tr>
<tr>
<td>Download and show studies by tag value.</td>
</tr>
<tr>
<td>Search in a specific PACS servers with AE title from the settings</td>
</tr>
<tr>
<td>mDicom.exe -pacsAETitle PACS_AETITLE -pacsTagValue 00100010 &quot;PatientName&quot;</td>
</tr>
<tr>
<td>Download and show studies by tag value.</td>
</tr>
<tr>
<td>Search in a specific PACS servers with AE title, IP, Port and Protocol</td>
</tr>
<tr>
<td>mDicom.exe -pacsServer &lt;AETITLE&gt;:&lt;IP&gt;:&lt;Port&gt;:&lt;Protocol&gt; -pacsTagValue 00100020 &quot;PatientID&quot;</td>
</tr>
<tr>
<td>Example: mDicom.exe -pacsServer AETITLE:192.168.1.10:4242:MOVE -pacsTagValue 00100020 John</td>
</tr>
</tbody>
</table>

**URL Protocol**

You may want to set up a type of link in the web application where if a user clicks on it, it will launch the MicroDicom DICOM Viewer. You need to use URL protocol `microdicom://`

All **command line arguments** can be used in URL protocol. The name of parameters has to be pass with "param" and value of this parameter with "value".

Sample:

**Open DICOM files and folders:**

mDicom.exe -fd "folder1" "folder2" file1 file2
microdicom://param=fd&value="folder1"&value="folder2"&value="file1"&value="file2"

**Scan for DICOM files and copy them to a folder**

mDicom.exe -scanAndCopy -in "c:\images" -out "c:\export"
microdicom://param=scanAndCopy&param=in&value="c:\images"&param=out&value="c:\export"

**Scan CD for DICOM files and copy them to a folder**

mDicom.exe -scanCDAAndCopy&param -out "c:\export"
Welcome to MicroDicom DICOM Viewer

microdicom://param=scanCDAndCopy&param=out&value="c:\export"

**Anonymize DICOM files**

mDicom.exe -anonymize -in "c:\images" -out "c:\export"
microdicom://param=anonymize&param=in&value="c:\images"&param=out&value="c:\export"

**Download and show studies by tag value**

mDicom.exe -pacsTagValue 00100010 "PatientName"
microdicom://param=pacsTagValue&value="00100010"&value="PatientName"

mDicom.exe -pacsAETitle orthanc -pacsTagValue 00100010 "PatientName"
microdicom://param="pacsAETitle"&value="orthanc"&param=pacsTagValue&value="00100010"&value="PatientName"

microdicom://param="pacsServer"&value="orthanc:192.168.1.10:4242:move"&param=pacsTagValue&value="00100010"&value="PatientName"
mDicom.exe -pacsServer orthanc:192.168.1.10:4242:move -pacsTagValue 00100010 "PatientName"

**Mouse functions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left mouse button + mouse move</td>
<td>Select/move/resize objects (annotations and measurements)</td>
</tr>
<tr>
<td>Right mouse button</td>
<td>Show context menu</td>
</tr>
<tr>
<td>Back mouse button + mouse move</td>
<td>Measure distance</td>
</tr>
<tr>
<td>Forward mouse button + mouse move</td>
<td>Use Freehand</td>
</tr>
<tr>
<td>Vertical mouse wheel</td>
<td>Next/previous image of series</td>
</tr>
<tr>
<td>Horizontal mouse wheel</td>
<td>Next/previous series</td>
</tr>
<tr>
<td>Ctrl + vertical mouse wheel</td>
<td>Zoom in/out image</td>
</tr>
<tr>
<td>Ctrl + left mouse button + mouse move</td>
<td>Pan image</td>
</tr>
<tr>
<td>Shift + left mouse button + mouse move</td>
<td>Tune image brightness/contrast</td>
</tr>
</tbody>
</table>
**Welcome to MicroDicom DICOM Viewer**

<table>
<thead>
<tr>
<th>(Windowing)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double click with left mouse button</td>
</tr>
<tr>
<td>Middle mouse button + mouse move</td>
</tr>
<tr>
<td>Ctrl + left mouse button on image in DICOM browser</td>
</tr>
</tbody>
</table>

**Multi-touch operations**

<table>
<thead>
<tr>
<th>One fingers over image</th>
<th>Drag to select/use tool, annotation or measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two fingers over image</td>
<td>Pinch to zoom/ drag to pan/ Rotate image</td>
</tr>
<tr>
<td>Double tab on image</td>
<td>Toggle full screen</td>
</tr>
</tbody>
</table>